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Chapter 1

Introduction

How to use this guide; related guides; software conventions; getting help

Welcome to the GatorMIM CS and GatorStar GX-M User’s Guide. We have 
designed this guide to serve as a reference for using NetSight Element Manager 
for the GatorMIM CS and the GatorStar GX-M.

The GatorMIM CS and GatorStar GX-M are LocalTalk to Ethernet routers—based 
on Cayman Systems’ GatorBOX-CS technology—which are integrated for use in 
the MMAC series of intelligent hubs. 

The GatorMIM CS is a LocalTalk router module for the MMAC hub, providing 
routing connectivity between LocalTalk and Ethernet topologies with AppleTalk 
and DECnet routing capabilities, with no configuration required. 

The GatorStar GX-M is a single module designed to plug into the MMAC hub, 
providing plug-and-play routing between LocalTalk and Ethernet networks, with 
no configuration required. It integrates the LocalTalk-Ethernet gateway with the 
24-port LocalTalk SmartRepeater. GatorStar GX-M’s SmartRepeater technology 
provides automatic detection and correction of “jabbering” on LocalTalk ports, 
and determines the location of individual nodes for each port, allowing network 
management and mapping programs to determine the location and traffic of 
every node on your LocalTalk network.

Both the GatorStar GX-M and the GatorMIM CS support LocalTalk Statistics and 
the SNMP System Group. The GatorStar also supports GatorStar Statistics. The 
GatorStar GX-M can support up to 96 users; the GatorMim CS up to 32 users. 
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Using the GatorMIM CS/GatorStar GX-M 
User’s Guide

Each chapter in this guide describes one major functionality or a collection of 
several smaller functionalities of the GatorMIM CS and the GatorStar GX-M. This 
guide contains information about software functions which are accessed directly 
from the device icon.

Chapter 1, Introduction, provides a list of related documentation, describes 
certain software conventions, and shows you how to contact the Global Technical 
Assistance Center.

Chapter 2, The Gator Module View, describes the visual display of the Gator 
module in the chassis and explains how to use the mouse within the Chassis 
View.

Chapter 3, LocalTalk and GatorStar Statistics, describes both the LocalTalk and 
Gator Total Repeater Statistics windows, and defines the various packets and 
errors forwarded across the GatorMIM CS and GatorStar GX-M as well as the 
total repeater statistics counted by the GatorStar GX-M.

Related Manuals
The GatorMIM and GatorStar User’s Guide is only part of a complete document 
set designed to provide comprehensive information about the features available 
to you through NetSight Element Manager. Other guides which include 
important information related to managing the Gator Module are as follows:

User’s Guide

Tools Guide 

Remote Administration Tools User’s Guide

Alarm and Event Handling User’s Guide

For more information about the capabilities of the Gator Module, consult the 
appropriate hardware documentation.

NOTE
The GatorStar GX-M and the GatorMIM CS will be jointly referred to as the Gator 
Module throughout much of this manual. Where there are differences, each device will be 
named separately, as necessary.
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Software Conventions
Your NetSight Element Manager’s device user interface contains a number of 
elements common to most windows and which operate the same regardless of the 
window in which they appear. A brief description of some of the most common 
elements appears below. The information provided here is not repeated in the 
descriptions of specific windows and/or functions.

Using the Mouse

This document assumes you are using a Windows-compatible mouse with two 
buttons; if you are using a three button mouse, you should ignore the operation of 
the middle button when following procedures in this document. Procedures 
within the NetSight Element Manager document set refer to these buttons as 
follows:

Figure 1-1. Mouse Buttons

For many mouse operations, this document assumes that the left (primary) mouse 
button is to be used, and references to activating a menu or button will not 
include instructions about which mouse button to use. 

However, in instances in which right (secondary) mouse button functionality is 
available, instructions will explicitly refer to right mouse button usage. Also, in 
situations where you may be switching between mouse buttons in the same area 
or window, instructions may also explicitly refer to both left and right mouse 
buttons.

Instructions to perform a mouse operation include the following terms:

• Pointing means to position the mouse cursor over an area without pressing 
either mouse button.

• Clicking means to position the mouse pointer over the indicated target, then 
press and release the appropriate mouse button. This is most commonly used 
to select or activate objects, such as menus or buttons. 

Left Mouse Button

Right Mouse Button
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• Double-clicking means to position the mouse pointer over the indicated 
target, then press and release the mouse button two times in rapid succession. 
This is commonly used to activate an object’s default operation, such as 
opening a window from an icon. Note that there is a distinction made between 
“click twice” and “double-click,” since “click twice” implies a slower motion. 

• Pressing means to position the mouse pointer over the indicated target, then 
press and hold the mouse button until the described action is completed. It is 
often a pre-cursor to Drag operations.

• Dragging means to move the mouse pointer across the screen while holding 
the mouse button down. It is often used for drag-and-drop operations to copy 
information from one window of the screen into another, and to highlight 
editable text.

Common Gator Module Window Fields

Similar descriptive information is displayed in boxes at the top of most Gator 
Module windows in NetSight Element Manager, as illustrated in Figure 1-2. 

Figure 1-2. Sample Window Showing Informational Boxes

Device Name
Displays the user-defined name of the device. The device name can be changed 
via the System Group window; see the Generic SNMP User’s Guide for details.

IP Address
Displays the device’s IP (Internet Protocol) Address; this will be the IP address 
used to define the device icon. IP addresses are assigned via local management for 
the Gator Modules; they cannot be changed via NetSight Element Manager.

Device 
Name

IP Address

MAC 
Address
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MAC Address
Displays the manufacturer-set MAC address of the device interface. This address 
is factory-set and cannot be altered.

Using Window Buttons

The Cancel button that appears at the bottom of most windows allows you to exit 
a window and terminate any unsaved changes you have made. You may also 
have to use this button to close a window after you have made any necessary 
changes and set them by clicking on an OK, Set, or Apply button.

An OK, Set, or Apply button appears in windows that have configurable values; 
it allows you to confirm and SET changes you have made to those values. In some 
windows, you may have to use this button to confirm each individual set; in other 
windows, you can set several values at once and confirm the sets with one click 
on the button.

The Help button brings up a Help text box with information specific to the 
current window. For more information concerning Help buttons, see Getting 
Help, page 1-5.

The command buttons, for example Bridge, call up a menu listing the windows, 
screens, or commands available for that topic.

Any menu topic followed by ... (three dots) — for example Statistics... — calls up 
a window or screen associated with that topic.

Getting Help
This section describes different methods of getting help for questions or concerns 
you may have while using NetSight Element Manager.

Using On-Line Help

You can use the Gator Module window Help buttons to obtain information 
specific to the device. When you click on a Help button, a window will appear 
which contains context-sensitive on-screen documentation that will assist you in 
the use of the windows and their associated command and menu options. Note 
that if a Help button is grayed out, on-line help has not yet been implemented for 
the associated window.

From the Help menu accessed from the Module View window menu bar, you can 
access on-line Help specific to the Module View window, as well as bring up the 
Chassis Manager window for reference. Refer to Chapter 2, The Gator Module 
View, for information on the Module View and Chassis Manager windows.
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Accessing On-line Documentation

The complete suite of documents available for NetSight Element Manager can be 
accessed via a menu option available from the primary window menu bar: 
Help—>Online Documents. If you chose to install the documentation when you 
installed NetSight Element Manager, selecting this option will launch Adobe’s 
Acrobat Reader and a menu file which provides links to all other available 
documents.

Getting Help from the Global Technical Assistance Center

If you need technical support related to NetSight Element Manager, contact the 
Global Technical Assistance Center via one of the following methods:

By phone: (603) 332-9400
24 hours a day, 365 days a year

By fax: (603) 337-3075

By mail: Enterasys Networks
Technical Support
35 Industrial Way
Rochester, NH 03867

By e-mail: support@enterasys.com

FTP: ftp.ctron.com (134.141.197.25)

Login anonymous
Password your e-mail address

By BBS: (603) 335-3358

Modem Setting 8N1: 8 data bits, 1 stop bit, No parity

NOTE
All of the online help windows use the standard Microsoft Windows help facility. If you 
are unfamiliar with this feature of Windows, you can select Help from the Windows 
Start menu, or Help —> How to Use Help from the primary NetSight Element 
Manager window.

TIP

If you have not yet installed the documentation, the Online Documents option will not 
be accessible from the menu file; in order to activate this option, you must run the 
setup.exe again to install the documentation component. See your Installation Guide 
for details.
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Send your questions, comments, and suggestions regarding NetSight 
documentation to NetSight Technical Communications via the following e-mail 
address:

Netsight_docs@enterasys.com

To locate product specific information, refer to the Enterasys Web site:

http://www.enterasys.com

NOTE
For the highest firmware versions successfully tested with NetSight Element Manager 
2.2.1, refer to the Readme file available from the NetSight Element Manager 2.2.1 program 
group. If you have an earlier version of firmware and experience problems, contact the 
Global Technical Assistance Center.
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The Gator Module View

Information displayed in the Module View window; Chassis Manager window; enabling and disabling 
ports

The Gator Module View window is the main screen that immediately informs you 
of the current configuration of the ports on your Gator Module. Because the Gator 
Module functions as a stand-alone IMIM (Intelligent Media Interface Module), 
other MIMs in the MMAC chassis will not be visible. The default Logical View 
displays the condition of individual ports on the Gator Module; the Physical View 
provides a graphical representation of the actual board face. The Module View 
window serves as a single point of access to all other Gator Module windows, 
which are discussed at length in the following chapter.

To access the Gator Module View window, use one of the following options:

1. In any map, list, or tree view, double-click the Gator Module icon you wish to 
manage;

Figure 2-1. Gator Module icon

or

1. In any map, list, or tree view, click the Gator Module you wish to manage, and 
select Manage—>Node  from the primary window menu bar, or select the 
Manage Node  toolbar button.

or



The Gator Module View

2-2 Viewing Device Information

1. In any map, list, or tree view, click the right mouse button to select the Gator 
Module you wish to manage, and on the resulting menu, click Manage.

Viewing Device Information
The Gator Module View window (Figure 2-2) provides a graphic representation 
of the Gator Module, including a color-coded port display which immediately 
informs you of the current configuration and status of the ports on the module.

Figure 2-2. Module View Window—GatorStar GX-M and GatorMIM CS

By clicking in designated areas of the graphical display, or by using the menu bar 
at the top of the Module View window, you can access device-, board-, and 
port-level information.

TIP

When you move the mouse cursor over a management “hot spot” the cursor icon changes 
into a “hand” ( ) to indicate that clicking in the current location will bring up a 
management option.
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Front Panel Information

The section below the main port display provides the following device 
information:

Connection Status 
This color-coded icon indicates the current state of communication between 
NetSight Element Manager and the Gator Module.

• Green indicates the Gator Module is responding to device polls (valid 
connection).

• Blue indicates an unknown contact status — polling has not yet been 
established with the Gator Module.

• Red indicates the Gator Module is not responding to device polls (device is off 
line, or device polling has failed across the network for some other reason).

UpTime
The amount of time, in a days hh:mm:ss format, that the Gator Module has been 
running since the last start-up.

Port Status
If management for your device supports a variable port display (see the Gator 
Module Port Status Display, page 2-6), this field will show the display currently 
in effect. If only a single port display is available -- or if the default view is in 
effect -- this field will state Default.

MAC
The physical layer address assigned to the Gator Module’s Ethernet interface. 
MAC addresses are hard-coded in the device, and are not configurable.

Firmware
The revision of device firmware stored in the Gator Module’s FLASH PROMs.

Boot Prom, Time, and Date
These fields are not supported.

IP
The Internet Protocol address assigned to the Gator Module is displayed in the 
title bar; this field will display the IP address you have used to create the Gator 
Module icon. IP addresses are assigned via Local Management.

NOTE
Up to 24 ports can be displayed simultaneously on a module. If a module has a higher port 
density than 24 ports, Up and Down arrows will appear at the top and bottom of the port 
stack so that you can scroll through the remaining ports.



The Gator Module View

2-4 Viewing Device Information

Menu Structure

By clicking on various areas of the Gator Module’s Module View display, you can 
access menus with device-, board-, and port-level options, as well as utility 
applications which apply to the device as a whole. Figure 2-3 displays the menu 
structure and indicates how to use the mouse to access the various menus.

Figure 2-3. Gator Module View Menu Structure

The Device Menu
From the Device Menu at the Module View window menu bar, you can access the 
following selections:

• Device Type displays a description of the device being modeled; see Viewing 
the Device Type, page 2-7, for details.

• LocalTalk Statistics displays packets and errors forwarded across the Gator 
Module in both numeric and pie chart form; see LocalTalk and GatorStar 
Statistics, in Chapter 3, for more information.

• System Group allows you to manage the Gator Module via SNMP MIB II. 
Refer to the Generic SNMP User’s Guide for further information.

Device menu for 
the GatorStar 
GX-M

Device menu for 
the GatorMIM CS

Port menu is 
available for the 
GatorMIM CS 
only
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• I/F Summary displays statistics for the traffic processed by each network 
interface on your device; seeViewing I/F Summary Information, page 2-8, for 
details.

• Exit closes the Gator Module View window.

In addition to the previously-mentioned selections, the GatorStar GX-M also 
gives you access to the following selection:

• GatorStar Statistics displays total repeater statistics for the GatorStar GX-M in 
both numeric and pie chart format; see LocalTalk and GatorStar Statistics, in 
Chapter 3, for more information.

The Utilities Menu
The Utilities Menu has the following selection:

• MIB Tools provides direct access to the device’s MIB information; refer to the 
Tools Guide for a thorough explanation of the MIB Tools utility.

MIB Tools is also available from the Tools menu at the top of NetSight Element 
Manager’s primary window. 

The Help Menu
The Help Menu has the following three selections:

• MIBs Supported opens the Chassis Manager window, see The Chassis 
Manager Window, page 2-6, for details.

• Chassis Manager Help opens a help window with information specifically 
related to using the Chassis Manager and Module View windows.

• About Chassis Manager displays a window with the Chassis Manager 
version number.

The Board Menus
The Board menu provides access to the following menu selection:

• Module Type displays a description of the selected board; see Viewing the 
Module Type, page 2-7.

The Port Menus
The Port menu is available on the GatorMIM CS only, and has the following 
selections:

• Description displays a description of the interface type; see Viewing the Port 
Type, page 2-8, for details. 

• Enable/Disable allows you to enable or disable the selected port; see Enabling 
and Disabling Ports, page 2-14, for details.
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Gator Module Port Status Display

The Port Status display varies for each module type. The status conditions for the 
GatorMIM CS are:

ON (Green) The port is on-line and forwarding packets 
across the Gator Module from one network 
segment to another.

OFF (Red) The port has been disabled by management; no 
traffic can be received or forwarded on this port.

? (Blue) The status of ports cannot be determined by the 
software.

The status conditions for the GatorStar GX-M are:

ENB (Yellow/Enabled) The port is enabled, but not connected to a 
device; hence, no packets are being forwarded.

DIS (Red/Disabled) The port has been disabled by management; no 
traffic can be received or forwarded on this port.

? (Blue/Unknown) The status of ports cannot be determined by the 
software.

NLK (Yellow/No Link) The port has been disabled automatically 
because of excessive SWOP, activity, or 
jabbering. You will be able to re-enable the port 
when the offending condition no longer exists.

The Chassis Manager Window

The Chassis Manager window, Figure 2-4, is a read-only window that displays the 
MIBs and the MIB components — and, therefore, the functionality — supported 
by the currently monitored device. 

1. Select Help—>MIBs Supported  in the menu bar. The Chassis Manager 
window opens. 
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Figure 2-4. Chassis Manager Window

Viewing Hardware Types

Menu options at several levels provide specific information about the physical 
characteristics of the Gator Module and its ports.

Viewing the Device Type

The Device Type displays a description of the device being modeled.

1. Select Device—>Device Type  in the Module View menu bar. The Device 
Type window (Figure 2-5) opens.

Figure 2-5. Device Type Windows

Viewing the Module Type

From the Board menu on the Gator Module View window, you can view a 
description of the Gator Module type.

1. Click on the Board  number to reveal the Board menu.

2. Click on Module Type . A Module Type window, similar to the examples shown 
in Figure 2-6, opens describing the board type.

The MIBs which provide the 
Gator Module’s functionality — 
both proprietary MIBs and IETF 
RFCs — are listed here

The Gator Module does not
support MIB Components.
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Figure 2-6. Sample Module Type Window

Viewing the Port Type

You can view a brief description of the ports on your Gator MIM CS via the Port 
menu; this option is not available for Gator Star GX-M ports.

1. Click on the appropriate Port to display the Port menu.

2. Click Description. The Interface Description window, Figure 2-7, opens.

Figure 2-7. Sample Interface Description Window

Viewing I/F Summary Information

The I/F Summary option lets you view statistics for the traffic processed by each 
network interface on your device. The window also provides access to a detailed 
statistics window that breaks down Transmit and Receive traffic for each 
interface.

To access the I/F Summary window:

1. Select Device—>I/F Summary on the Module View menu bar. The I/F 
Summary window, Figure 2-8, opens.
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Figure 2-8. I/F Summary Window

The I/F Summary window provides a variety of descriptive information about 
each interface on your device, as well as statistics which display each interface’s 
performance.

Index
The index value assigned to each interface on the device.

Type
The type of the interface, distinguished by the physical/link protocol(s) running 
immediately below the network layer (e.g., ethernet-csmacd). 

Description
A text description of the interface.

Physical Status
Displays the current physical status — or operational state — of the interface: 
Online or Offline.

Logical Status
Displays the current logical status — or administrative state — of the interface: 
Up or Down.

Interface Performance Statistics/Bar Graphs

The statistical values (and, where available, the accompanying bar graphs) to the 
right of the interface description fields provide a quick summary of interface 
performance. You can select the statistical value you want to display and the units 
in which you want those values displayed by using the two menu fields directly 
above the interface display area, as follows:
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1. In the right-most menu field, click to select the unit in which you wish to 
display the selected statistic: Load, Raw Counts, or Rate.

2. Once you have selected the base unit, click in the left-most field to specify the 
statistic you would like to display. Note that the options available from this 
menu will vary depending on the base unit you have selected.

After you select a new display mode, the statistics (and graphs, where applicable) 
will refresh to reflect the current choice, as described below.

Raw Counts
The total count of network traffic received or transmitted on the indicated 
interface since device counters were last reset. Raw counts are provided for the 
following parameters:

In Octets Octets received on the interface, including framing 
characters.

In Packets Packets (both unicast and non-unicast) received by the 
device interface and delivered to a higher-layer protocol.

In Discards Packets received by the device interface that were 
discarded even though no errors prevented them from 
being delivered to a higher layer protocol (e.g., to free up 
buffer space in the device).

In Errors Packets received by the device interface that contained 
errors that prevented them from being delivered to a 
higher-layer protocol.

In Unknown Packets received by the device interface that were 
discarded because of an unknown or unsupported 
protocol.

Out Octets Octets transmitted by the interface, including framing 
characters.

Out Packets Packets transmitted, at the request of a higher level 
protocol, by the device interface to a subnetwork address 
(both unicast and non-unicast).

Out Discards Outbound packets that were discarded by the device 
interface even though no errors were detected that 
would prevent them from being transmitted. A possible 
reason for discard would be to free up buffer space in the 
device.

NOTE
Bar graphs are only available when Load is the selected base unit; if you select Raw 
Counts or Rate, the Bar Graph column will be removed from the interface display.
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Out Errors Outbound packets that could not be transmitted by the 
device interface because they contained errors.

Load
The number of bytes processed by the indicated interface during the last poll 
interval in comparison to the theoretical maximum load for that interface type 
(10 Mbps for standard Ethernet). Load is further defined by the following 
parameters:

In Octets The number of bytes received by this interface, expressed 
as a percentage of the theoretical maximum load.

Out Octets The number of bytes transmitted by this interface, 
expressed as a percentage of the theoretical maximum 
load.

When you select this option, a Bar Graph field will be added to the interface 
display area; this field is only available when Load is the selected base unit.

Rate
The count for the selected statistic during the last poll interval. The available 
parameters are the same as those provided for Raw Counts. Refer to the Raw 
Counts section, page 2-10, for a complete description of each parameter.

Viewing Interface Detail

The I/F Statistics window provides detailed statistical information — counts for 
both transmit and receive packets, and error and buffering information — for 
each individual interface. Color-coded pie charts also let you graphically view 
statistics for both received and transmitted Unicast, Multicast, Discarded, and 
Error packets. 

To open the Interface Statistics window:

1. In the I/F Summary window, click to select the interface for which you would 
like to view more detailed statistics. 

2. Click Detail. The appropriate I/F Statistics window, Figure 2-9, opens.
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Figure 2-9. Interface Detail Window

Three informational fields appear in the upper portion of the window:

Description
Displays the interface description for the currently selected interface.

Address
Displays the MAC (physical) address of the selected interface.

Type
Displays the interface type of the selected port (e.g., ethernet-csmacd).

The lower portion of the window provides the following transmit and receive 
statistics. The first four statistics are also graphically displayed in the pie charts. 

Unicast
Displays the number of packets transmitted to or received from this interface that 
had a single, unique destination address. These statistics are displayed in the pie 
chart, color-coded green.

Non-Unicast
Displays the number of packets transmitted to or received from this interface that 
had a destination address that is recognized by more than one device on the 
network segment. The multicast field includes a count of broadcast packets — 
those that are recognized by all devices on a segment. These statistics are 
displayed in the pie chart, color-coded dark blue.
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Discarded
Displays the number of packets which were discarded even though they 
contained no errors that would prevent transmission. Good packets are typically 
discarded to free up buffer space when the network becomes very busy; if this is 
occurring routinely, it usually means that network traffic is overwhelming the 
device. To solve this problem, you may need to re-configure your bridging 
parameters, or perhaps re-configure your network to add additional bridges or 
switches. 

These statistics are displayed in the pie chart, color-coded magenta.

Error
Displays the number of packets received or transmitted that contained errors. 
These statistics are displayed in the pie chart, color-coded red.

Unknown Protocol (Received only)
Displays the number of packets received which were discarded because they were 
created under an unknown or unsupported protocol. 

Packets Received (Received only)
Displays the number of packets received by the selected interface.

Transmit Queue Size (Transmit only)
Displays the number of packets currently queued for transmission from this 
interface. The amount of device memory devoted to buffer space, and the traffic 
level on the target network, determine how large the output packet queue can 
grow before the MRXI will begin to discard packets.

Packets Transmitted (Transmit only)
Displays the number of packets transmitted by this interface.

Making Sense of Detail Statistics

By using a few simple calculations, the I/F Statistics window can give you an idea 
of the interface’s activity level and how the interface is performing .

To calculate the percentage of input errors:

Received Errors /Packets Received

To calculate the percentage of output errors:

Transmitted Errors /Packets Transmitted

To calculate the total number of inbound and outbound discards:

Received Discards + Transmitted Discards

To calculate the percentage of inbound packets that were discarded:

Received Discards /Packets Received
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To calculate the percentage of outbound packets that were discarded:

Transmit Discards /Packets Transmitted

Enabling and Disabling Ports
From the Port menus on the GatorMIM CS Module, you can enable and disable 
any individual ports.

To enable or disable a port:

1. Click on the desired Port to display the Port menu.

2. Click Enable to enable the port, or Disable to disable the port. Your port will 
now be enabled or disabled as desired. 

NOTE
The Interface Statistics window does not offer Disable or Test options. These options are 
available in the Interface Group window, which can be accessed via the System Group 
window (select System Group from the Device menu). Refer to your Generic SNMP 
User’s Guide for more information on the System Group and Interface Group windows.
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LocalTalk and GatorStar Statistics

LocalTalk Statistics window; Total Repeater Statistics window

Viewing LocalTalk Statistics
The LocalTalk Statistics window (Figure 3-1) displays accumulated statistics and 
error breakdowns at the device level for the LocalTalk side of the Gator module. 
Statistics are displayed in numeric form and in graphic form as a pie chart.

1. Select Device—>LocalTalk Statistics in the Module View menu bar. The 
LocalTalk Statistics window, as shown in, Figure 3-1, opens.

Figure 3-1. LocalTalk Statistics
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The following packet and error statistics appear within the LocalTalk Statistics 
window:

Packets Fields
The Packet Fields display general performance information on the LocalTalk 
interface are as follows:

In Packets The total number of good packets received by the 
LocalTalk interface.

Out Packets The total number of packets transmitted from the 
LocalTalk interface.

Hard Errors
Hard errors are error conditions caused by physical layer problems, such as faults 
in the hardware, equipment, or wiring. Hard error fields are as follows:

In Errors The total number of packets containing errors received 
on the LocalTalk interface. In Errors are color-coded 
magenta.

Collisions The total number of collisions assumed on the LocalTalk 
interface due to the lack of a lapCTS (link access protocol 
Clear To Send) reply. Collisions are color-coded red.

Soft Errors
Soft errors are error conditions caused by corrupted data signals, such as failure 
along the transmission path. Soft error fields are as follows:

In No Handlers The total number of good packets received on the 
LocalTalk interface for which there was no protocol 
handler. In No Handlers are color-coded green.

In Length Errors The total number of packets received on the LocalTalk 
interface in which the actual packet length did not match 
the length specified in the header. In Length Errors are 
color-coded yellow.

Defers The total number of times the LocalTalk interface 
deferred to other packets (postponed sending a packet 
until after packets from other ports had already been 
sent). This usually indicates that the network was busy 
when the port wanted to send data. The link has to be 
idle for at least 400 microseconds before it will start to 
transmit.

No Data Errors The total number of times the LocalTalk interface 
received a lapRTS (link access protocol Request To Send) 
packet and expected a data packet, but did not receive 
any data packets.
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Random CTS Errors The total number of times the LocalTalk interface 
received a lapCTS packet that was not solicited by a 
lapRTS packet.

FCS Errors The total number of times the LocalTalk interface 
received a packet with an FCS (Frame Check Sequence) 
error. When a packet is transmitted, the MAC layer of the 
transmitting device computes an FCS value based on the 
contents of the packet, and appends that value to the 
packet. The receiving station performs the same 
computation. If the FCS values differ, the packet is 
assumed to be corrupted.

Gator Total Repeater Statistics 
The Gator Total Repeater Statistics window displays the total number of repeater 
statistics and error breakdowns at the device level for the GatorStar GX-M only. 
The pie chart to the right of the statistics text boxes allows you to graphically view 
the statistics. 

By using the Total and Delta option buttons, you can change the time period 
during which statistical data is collected. Total gathers data from the device and 
updates it at each subsequent polling interval. After the completion of the current 
polling cycle plus one complete polling cycle, the window will display the sum of 
statistics processed since the device was last restarted. Delta gathers data during 
the last polling interval (after the completion of the current polling cycle plus two 
more polling cycles). These counts are refreshed after each polling cycle.

1. Select Device—>GatorStar Statistics in the Module View menu bar. The 
Gator Total Repeater Statistics window, Figure 3-2, opens.

Figure 3-2. Gator Total Repeater Statistics Window
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The following fields appear within the Gator Total Repeater Statistics window:

Packets Fields
Total Packets The total number of packets processed by the 

device since the last reset. Total Packets are 
color-coded green.

Error Fields
Total Jabbers The total number of packets since the last reset 

that were oversized (greater than 1518 bytes — 
a Giant packet), and had either a non-integral 
number of bytes (alignment error) or a bad frame 
check sequence (CRC error). Total Jabbers are 
color-coded yellow.

Total Swops The total number of SWOP (Sync Without 
Packet) conditions since the last reset. Total 
Swops are color-coded magenta.

Spurious Interrupts The total number of spurious (invalid) interrupts 
on the device since the last reset.

Received Packets The total number of good packets received with 
no errors since the last reset.

Too Long Packets The total number of packets greater than the 
maximum allowable number seen on the device 
since the last reset.

Alignment Errors The total number of misaligned packets seen on 
the device since the last reset. A misaligned 
packet is one that does not contain an integral 
number of bytes.

Received Aborts The number of packets that were aborted during 
the receive process since the last reset.

CRC Errors The total number of packets with CRC (Cyclical 
Redundancy Check) errors seen on the device 
since the last reset. CRC errors occur when the 
element responsible for either the transmit or 
receive CRC calculation is malfunctioning, 
which causes good packets to be discarded as 
errors. 

Overrun Errors The total number of overrun conditions seen on 
the device since the last reset. An overrun occurs 
when the processor cannot keep up with the 
inbound byte stream.

CD Lost The total number of CD Lost (Carrier Detect 
Lost) errors seen on the device since the last 
reset.
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